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Insert the CD into the drive and follow the instructions.

With the start button of the task manager you can choose Program/is-den-
tal/Assistant

The program can be started by a double click on the program icon Assistant,
by the dock or the menu. In order to get a quick start, it is advisable to insert
an Alias into the apple menu or to put the program icon in the clock (please
find more detailed information in the handbook of your computer).

When you start your „Assistant“ for
the first time after its installation, the
system number - red number - will
appear in the registration-window.
Please type this number combination
on the enclosed register form.
Then fax us this form or send it by
post ASAP.
The password, with which you can
activate the program will be obtained
and sent to you by us within a few
minutes.

Installation

Registration

Programstart
Windows

Programstart
Macintosh

Please check the colour depth of your monitor. Optimal  is 16 bit/64000
colours
Check the currency setting 
Place the "lists” folder in "own files” 
Delete any lists that are not required

Start guide

Assistant runs on all Macintosh and Pentium computers.

• Min. requirements Windows 98 
• Min. 64 MB free RAM storage after starting the system
• Approx. at least 200 MB free storage on the hard disk
• Colour monitor (at least 64000 colours)
• Cd - Drive for installation

Requirements
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It is advisable to proceed in a logical order to help the
patient comprehend the process.

Example structure
1. Step - drawing up of status

Click on the symbol for lower jaw. The top view of the jaw
appears on the screen.

Choose the option missing by a mouse click. On the illus-
tration you can click away every tooth as long as the stroke
flashes. The second click rebuilds the tooth again.

Now we are in the main menu. 
You can guide for the programmed sections by clicking on picture symbols,
the menu strip or by keyboard.

Main menu

Missing

Working with
Assistant
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Activate filling and click on a front tooth. The tooth gets a plastic filling.

1st click  = old plastic filling
2nd click = filling in the colour of the tooth
3rd click = starting position

Leave the option filling activated and choose a side tooth.
For the side teeth there are several options:

1st click  = amalgam filling
2nd click = inlay o
3rd click = inlay mo
4th click = inlay od
5th click = inlay mod
6th click = old plastic filling
7th click = filling in the colour of the tooth
8th click = starting position

Filling

Most of the options are provided with multiple clicks. You can click repea-
tedly until the desired element is presented. Only by this kind of controlling
it is possible to present the option list clearly and to preserve such a fast
structure of a situation as well as the corresponding prosthodontial alterna-
tives.

The division of the plate in two parts also enables the reduction of the
countless combinations to little clicks per jaw half.

Reaction 
surfaces

click
here

click
here C

lic
k
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re

click
here
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The practical experience has proven that fillings and teeth, which are in need
of treatment, should be built up before.
The acceptance of the extraction or the making up of the preparation increa-
ses if you devote some seconds to build up a complete status.

Now we come to reconstruction. 

Choose again the option filling and remove non-preservable teeth.

At first, the crowned teeth should be prepared (choose option preparation
and click on the corresponding teeth).
1st click: preparation
2nd click: root-canal-filling

Activate the option crown and click on the corresponding tooth.

1st click = veneer crown
2ndclick = bridge part (element narrower)
3rdclick = plastic veneer crown
4th click = plastic veneer bridge component
For the side tooth there are also all-cast crowns fixed.

Preparation

Crowns and
bridges

Implants If you choose the option implants, the 1st click builds up a screw implant as a
basis for a bridge part.
The 2nd click shows an implant with crown
The 3rd click shows an implant with a secondary part for the denture
(Anchor version)

The Option "Attachment / bar" opens a tool window.
Click one of the symbols. The item will be placed on the free surface
beside the window 

Anchor and
attachment
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These items can be shifted with pressed mouse onto any
positions. 

pressed
mouse

Hold shift key

Pressed mouse button = item shift
Pressed mouse button and pressed SHIFT key = item turn



9

Lower jaw Choose the option plate in the lower jaw and click on the space where the bar
is to be built up. 
On the corresponding half of the jaw appears a sublingual bar, connecting the
space from the first to the 7th and 8th teeth. Following clicks will shorten the
bar. The ends which reach into the interproximal space can be used as a con-
nector of clasps, individual attachment and telescopic crowns.
With a click on the counterpart you can continue building up the necessary
bar connection.

By a click on the part of the base of artificial dentures a half of the full plate
appears.
By further clicks you will get two additional variants of a full plate. In the
following a horseshoe arch plate appears which will be scaled down by every
further click.

Metal plate It is useful to place the plate in front of the sadd-
les. Because of the variety of the connecting possi-
bilities the building up in this row is clearer and
faster. At the missing you can clearly see the right
dimension of the base.
The division of the plate enables the reduction of
the uncountable combinations to little clicks per
jaw.

Upper jaw

If you need a major connector, choose the corresponding option and click on
the desired space.
With this order you also have the possibility to build up or to cut back the
lateral border.

Major
connector

Saddle Choose the option artificial tooth and click on the corresponding tooth. 
Because of different metal frame and saddle ends a multitude of variations is
at your disposal. While working with the program, however, you will quit
fast get accostumed to the system of the construction.

1st Click = saddle for single tooth
2nd Click = saddle, mesial edge, distal open
3rd Click = saddle, open at both edge
4th Click = saddle, distal edge, mesial open

It is not necessary to learn the order of  the „building up“. It is enough to
click as long as the corresponding part appears.
More teeth - show plastic plate
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Plastic plate

Saddle 2

Choose plastic plate and just as dealing with metal base, click on the corres-
ponding basic elements. After the first click, half synthetic base appears with
collar setting as far as the 7th tooth. The second click makes a small base
appear on the screen as far as the 5th tooth. With a 3rd click we obtain a com-
plete jaw covering. The space outside is not changed. A fourth click brings
the entire prosthesis on the screen. 
The open spaces shown by the third click are necessary - among other things
- to highlight telescope and implants in a better way.

The fitting of synthetic teeth differs greatly from the procedure of attaching
artifical teeth to a metal base.

Stay on option „plastic plate“ and simply click on the teeth.

The open spaces shown by the third click are
necessary - among other things - to highlight
telescope and implants in a better way. 
Choose „telescope“ fit primary part and then
show overtelescope when dealing with option
„missing“ clear up the space, fit implant and
then cover the hole with an artificial tooth.
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Estimate 
Reference Guide

Assistant-Prosthetic writes the usual prosthodontic abbreviations into a
mask in the background.

After setting up the prosthetic treatment, click on "calculator”. A field with a
code bar will appear. Please note that in this section, it is very important to
observe the following sequence:

• Category selection (crowns and bridges, combination work etc.). Should
you wish to calculate an individual item such as, for e.g., an additional
crown, please select "without category”

• Alloy selection
• List selection
• Calculate

Calculator

Results If you click on "results”, a listing of the work will be shown.



Prices are indicated in each of the different lists
and can be accessed by selecting the item marked
"select list”. In this section, it is possible to save as
many lists as required.

You can obtain an explanation about a given area by clicking on one of the
question marks.

In order to have the correct pricing, it is necessary to review the practice’s
lists as well as the location-specifics.
To make changes, please select "change price”.
By selecting "open list”, you can call-up the list that has been provided by
us.
One can go through the list, from one position to the next (navigator) and
modify, as required.

12

Modifying Lists

List Selection
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Start-up List

All costs, including laboratory charges, should be totaled. Fees that cannot be
directly assigned to an individual tooth or crown etc, must be accounted for
via a category (category 1, for e.g., for crowns and bridges, category 2 for
combination work, category 3 for e.g., for model casts, clasps).
Only the total price (= the practice price) is important for making calcula-
tions with the calculator. It is however also possible to have the laboratory
fill in any laboratory work. In the folder titled "is-dental/tools”, you will
find a PDF file called "pricing”. These forms can be printed out and given to
the laboratory to fill out and the information can subsequently be entered
into your own lists. 

Once you are certain that all of the positions contain the correct prices, save
the list under a name of your choice. 

It is possible to save the most frequently used list as the start-up list.

Practice Prices

Laboratory prices are calculated in a similar fashion as the practice prices: all
charges that can be assigned to a particular tooth or crown etc., are assigned
under each of the individual items. Fees that cannot be assigned to an indivi-
dual tooth or crown etc. must be accounted for using a category (category 1,
for e.g., for crowns and bridges etc.).

Laboratory 
Prices
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Metal Weight Please note that the average metal weight should be entered in the field mar-
ked "metal weight”.

Metal Prices For the calculation of the price of a metal, three price categories are provi-
ded (see "preferences”). The prices for metal are not included in the labora-
tory charges but rather are added separately through the selection of an
alloy under "estimate”. This is also the case with regards to the prices for
material.

Changing the
Currency Setting

One can enter the desired currency under the field marked "new” and then
select "confirm”.
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List of
abbreviations

ca1 basic charge 1 (General cost,  models etc)
ca2 basic charge 2
ca3 basic charge 2
Rcf root-canal filling
CC crown with porc.. Veneer
BC bridge part with porc. Veneer
FC full ceramic crown
FB full ceramic bridge
CV plastic veneer crown
BV plastic veneer bridge
C full crown
B full bridge part
T telescopic crown
TV telescopic crown; veneered
AC indiv. attachment, ceramic veneered
AV indiv. attachment, plastic veneered
A indiv. attachment, full crown
aA anchor
cA attachment
B bar attachment
MP metal plate
PP plastic plate
Cl clasps
Clc clasps on crown
Clp clasps on vennered crown
Rf replaced tooth, front 
R replaced tooth, side
o inlay occlusal
mo inlay mesial / occlusal
od inlay occlusal / distal
mod inlay mesial / occlusal / distal
kf inlay, full ceramic
I implants
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Movies After building up it is advisable to start an example film. At first, choose the
corresponding film by clicking on the item examples in the upper menu strip.
A separate window opens in which the animation is run. The films show the
therapy in a short form.
We have intentionally refused on video sequences, in order to avoid disgust
of sensitive patients. After presenting the creation of e.g., new bridge part, to
the patient, close the window and go back to the building up.

Technical advice If the example movies run faltering, your computer probably does not have
enough working capacity. Before starting „Assistant“, end all other present
applications. If the memory does not have enough capacity, avoid starting
the film at this moment. Start the example after the completion of the buil-
ding up from the main menu by the corresponding buttons. In this moment
your working storage is only used minimal by the background.

Attachment By clicking on the mouse, the attachment can be moved

The movies „anchor and bars“ are self-running
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The three movies
• Implants with anchor
• Implants with bar
• Implants for crowns
are self-running

Implants

Self-running movie

The movie starts with a self-running part. At the end of
the preparation select the desired type of crown 

Telescope

Crowns

By clicking on the mouse, the magnifying
glass can be positioned on any part of the
illustration.

Magnifying
Glass
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Bleaching Through the slide control, a definitive brightening can be simulated in three
colour ranges.

Three films (fracture, correction and Diastima) can be called up, limited to
the basic requirements of the patient, which show both the preparation of
and the insertion of the veneers.  

Veneers

Extraction For extraction you have two examples.

Atrophy:
Click on the arrow

Elongation:
self-running

CPITN
Community
Periodontal
Index of Treat-
ment Needs

After selection of the appropriate code 0-4 the measure-
ment is simulated. The different damage levels are shown.

Clasps With this film you can select between different clasps.
The film shows the integration of the prosthesis
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Fillings After a short preparation the film is stopping. It is possi-
ble to show different fillings.

Preparation Self-running movies 

In this section of the program you have the option of demonstrating the cos-
metic/optical effect. 
Two different versions are available:
With an open mouth without a lip cover, all metal crowns and metal purchase
surfaces, inlays, braces, synthetic saddles are clearly visible. With regards to
the front view, the length of the clasps can be changed with the use of the
mouse.
The second view shows the cosmetic effect with the mouth slightly opened,
with lip cover.
The front view can only be saved as a picture or it can be printed out.

Front View

When dealing with the print out of the ASSISTANT program, the set out
situation will be printed directly as a single picture. If you want to provide
the pictures with captions or other texts, use your word processing, accoun-
ting program or our Form manager. More information look Form manager /
Import and Export

Picture export
Copy-paste



Good print results can be reached with Bubble jet printer
We have chosen the safest method for the printout of „Assistant“ pictures.
The relevant picture is frozen as a screen shot and transferred to the printer
as a picture.

This basis function of all operating systems offers
the greatest security and guarantees a problem
output.

20

Print image

Save image The results can be saved as an image and can be
used in image-, text- or presentation programs

Save construction Worked on material can be saved and called up again and modified as
required.

Select “Save”
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Form manager

About 
Databases

Fields

A database is a collection of information, or data, that you can organize,
update, sort, search through, and print as needed. Your own address book
or filing cabinet might be an example of a database. With the address book
and filing cabinet, you store similar pieces of information organized for
easy retrieval. With a filing cabinet, you must choose a way to sort your
data, for example, alphabetically by last name or by region. By storing
contacts and addresses in FileMaker Pro, you can organize your informa-
tion in many ways. You can sort your information by country, city, last
name, or even sort by all three of these fields!
A database doesn’t just hold information—you use a database to organize
and analyze information so that you understand its significance. A databa-
se can be one file, which might hold the names, addresses, and telephone
and fax numbers of all your clients.
A database can also be many files that, together, contain all the informa-
tion about a particular topic, or related topics (sometimes called a database
system).

Before you begin to work with FileMaker Pro, you should be familiar
with the basics of a FileMaker Pro file and some simple database concepts.

Fields are the basis of a database file. Fields are used to store, calculate, and
display the data you enter into a record. Each piece of information in a
record—like name, ID number, and telephone number—is stored in a
field. A database file contains one or more records. Each record contains
fields that hold similar information about one subject or activity. To enter
data in a database file, you make a new record and enter data into the fields
that belong to that record. After you create records in a file, you can work
with them in various ways: you can edit them, sort them, find a group of
records that contains particular data, or share the data across a network.
Select a field  
Click in the field.
Move to the next field in the field order
Press Tab (or click in the field).
Move to the previous  field in the field order
Press Shift+Tab (or click in the field).
Delete data from a field
Select the data, then press Backspace or Delete
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Preferences for
the printing

Start

Patient data

Record

In order to print the practice / laboratory name on all printouts, select the
"Form" > "Settings" button in the Assistant. Enter your name and address, if and
when required, in the field edged in red. Use "Format" in the menu bar to indivi-
dually design the entry.

Use the "Form" button in the image bar or use Tools to start the Form Manager.
The patient data sheet is displayed first.

A data record is created for every patient. Within this data record you have the
various forms available once. If you should need a form twice for a patient, it is
best to duplicate the data record (cf. Duplicating a data record).

As a minimum, the name should be entered as it is transferred to all printouts.
However, it is also sensible to enter the
address as the letter paper is linked to the
patient data.

The fields described below facilitate the
search for certain cases.
Treatment provider - an interesting featu-
re in case of joint practices and dental
laboratories.
Headword - freely defined short descrip-
tion.
Category - can be selected in the pop-up
window (cf. Changing value list).
Suggestion - as in Category

To move from one record to another, use the book icon in the status area
One record at a time forward
Click the bottom page of the book icon
One record at a time backward 
Click the top page of the book icon
Quickly to a specific record
• Click the current record number at the bottom of the book icon, type the
record number you want, then press „Enter“ (Windows) or „Return“ (Mac
OS).
• Press Esc, type the record number, then press Enter or Return. 
Quickly through records 
Drag the bookmark down or up to move forward or backward.

Moving
through records
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A field can display values as pop-up  menus.You can use these options to
quickly enter preset data. The data is defined in value list

Click the field and then choose the value from the pop-up list

Choose Edit... then change the values in the dialog box. Click OK 

You see a blank record with one field selected. FileMaker Pro stores new
records at the end of the file.

To show all records again

Show all or all find records as list

See „explanation of forms“

This button goes to the form selection

Start image database

Change logo

Value list

Choose value

Edit a value list
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Quickly add a record with the same or similar data as an existing record:
Select the record to duplicate. Then, choose Records menu > Duplicate
Record. 

To find records, work in Find mode. You type criteria (the value or values to
find) into fields in a find request, which looks like a blank record. When you
perform the find, FileMaker Pro searches through all the records, comparing
the criteria with the data in the file. Records with data matching the criteria
are added to the found set, which is the subset of records being browsed.
You can use the Symbols pop-up menu to help you enter criteria that inclu-
de operators

When you delete a record, you permanently discard the data in all the fields
in that record.
Important: You can’t retrieve deleted data, and you can’t undo the action of
deleting records. Before you delete records, consider making a backup copy
of your file.

Duplicate
Record

Drag and Drop You can use drag and drop to transfer information within a FileMaker Pro
file or betweenFileMaker Pro and other applications that support drag and
drop
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Explanation of
forms

The procedure is identical in these forms.

-Use the mouse to click into the free surface to paste the
image from the clipboard into the marked frame.
- Remove the marking by clicking outside of the frame.
- The field allocated to the teeth can be used to enter indivi-
dual remarks.

The fields can be addressed by mouse and the tabulator key.

Lower jaw

Upper jaw Comparison of upper
and lower jaw with text
fields.

Important:

The forms shown above are linked to each other, which means that the individual
modeling is automatically transferred to the upper jaw and lower jaw page and to
the data sheet of the patient.

These forms have been set up for 2, 3 or 4 images
and can be provided with random images from
the Assistant or the catalog.
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The practice / laboratory name entered in Settings is automati-
cally transferred to the page for additional text information.

The practice / laboratory name as well as the address is trans-
ferred to the letter paper from the patient master data. If you
need another page for your letter, please use the form for text
information as page 2.

In the "CPITN" form, the images also have to be
pasted first. After the marking has been removed, the
code values determined can be entered in the corres-
ponding sextant.

The next three forms refer to the parodontal status.

After having pasted the image from the Assistant each
tooth of the upper and lower jaw can be provided with
the pocket depth (green), mobility (red) and/or recession
(blue).

Important note:

In order to print out the form, do not access "File -
print", but use the icons in the form bar.

Print
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Catalog

Import/Export

Start 

Clipboard

Drag and Drop

In the Form manager the catalog can be started by clicking on the "Catalog" tab.

You can copy a graphic, movie, or sound from a different application to the
Clipboard and then paste it into a FileMaker Pro container field.
• Cut or copy the graphic, movie, or sound to the Clipboard.
• In the FileMaker Pro file, switch to Browse mode and view the record to
paste into.
• Click the container field, then choose Edit menu > Paste.

You can use drag and drop to transfer information within a FileMaker Pro file
or between FileMaker Pro and other applications that support drag and drop
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Cataloging

Keywords

Inserting graphics into fields
• In Browse mode, click a container field.
• Choose Insert menu > Picture.
• In the dialog box, choose a file type for Files of type (Windows) or Show
(Mac OS).
Tip: You can use the Insert QuickTime command for file types supported
by QuickTime 3.0 or later. See the following section if you can’t find the
file type you want.
• Select the graphic file (change folders, if needed).
• Choose a storage option and then click Open.

To insert movies and QuickTime multimedia into a field:
• In Browse mode, click a container field.
• Choose Insert menu > QuickTime.
• In the dialog box, select the filename (change folders, if needed), then
click Open.
Mac OS: Select Show Preview to see a frame of the movie.

The allocations of names, treatment provider and/or keywords
are helpful to search images.
Name - Enter the patient name here. Any name corresponding
to your standard filing system can be used.
Treatment provider
Use "Edit" in this pop-up window to enter your name and/or
the name of the co-treatment providers in the practice, which
can be changed at any time.
One or several categories can be allocated to the image.

If you want to add your own keywords, click on 
"New keyword". The "Keywords" window will
open.
Use the "New" button to add new keywords and
remove keywords by clicking on "Delete". The 
"Present" button is used to display how many data
records are linked with this keyword.

QuickTime
movies

Inserting graphics
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Save

FileMaker provides three views of each layout: form, list and table.

Select the record to delete. 
Choose Records menu > Delete Record, then click Delete.
When you delete a record, you permanently discard the data in all the fields in
that record.
Important: You can’t retrieve deleted data, and you can’t undo the action of
deleting records. Before you delete records, consider making a backup copy
of your file.

Important
FileMaker saves changes you make to a file as you work and whenever you
close a file or quit the application.

You should save a copy of the file to backup your work.

Records view

Delete

Reference to
FileMaker

The Form Manager and the Catalog are run times created by File Maker. These
run times can be used in the form we provide them without having to buy the
"FileMaker" program.

Find records To find records, work in Find mode. You type criteria (the value or values to
find) into fields in a find request, which looks like a blank record. When you
perform the find, FileMaker Pro searches through all the records, comparing
the criteria with the data in the file. Records with data matching the criteria
are added to the found set, which is the subset of records being browsed.
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Graphic

QuickTime 

Sound

Multimedia and
Movie

Notes

Use the Insert QuickTime command to insert any file type supported by
QuickTime. For information about the file types, refer to the Apple
QuickTime web site at www.quicktime.com.

FlashPix (.FPX); GIF (.GIF); JPEG/JFIF (.JPG); MacPaint (.MAC); PDF
(.PDF, only Mac OS X); Photoshop (.PSD); PICS (.PCS); PICT (.PCT);
PNG (.PNFG); QuickTime Image File (.QT); SGI (.SGI); Targa (.TGA);
TIFF (.TIF); Windows Bitmap (.BMP); 

AIFF (.AIF); AU; Audio CD Data (Mac OS); MIDI (.MID); MP3 (.MP3);
SoundFont 2 (.SF2); Sound (.SND); WAV (.WAV); 

AVI (.AVI); DV (.DV); Cubic VR; FLC; Karaoke (.KAR); Macromedia
Flash 4; MPEG-1(Playback); QuickTime Movie (.QTM); QuickTime VR;
Virtual Reality (VR)

• In Windows OS, FileMaker imports Windows format files (.BMP),
MacPaint (.MAC, .PNT) and TIFF (.TIF) without using QuickTime.
• In Windows and Mac OS, the Insert > QuickTime command supports
all file types, which are also supported by the currently installed version
of QuickTime.
• In Mac OS X (other than in Mac OS) Add > QuickTime can enter films,
but no graphics files, such as JPEG, TIFF, et cetera. In order to import
other media files than films, use Add > Graphics.
• File types / extensions are taken into consideration by the individual
components of the QuickTime import function. Films and other media
data can thus be imported only, if they either have a valid file name exten-
sion or correspond to a valid Mac file type.
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1. Is-dental software is copyright and sold under license. You, as user, oblige
yourself to use the program exclusively for normal business activities.

2. The program should be used only in your computer / laboratory, in your
medical practice.

3. You are not allowed to authorize its use to anybody else, to sell, lease out,
rent out, distribute or put the disposal of other people.

4. The program and the pictures contained in it should not be changed, modi-
fied nor adapted. They may neither completely nor partially are combined
with other software programs. Moreover, nobody is allowed to produce deri-
vate software programs or other data words without written permission from
is-dental.

In case of justified complaint, we of course deliver new and flawless software
30 days after delivery date, to replace faulty or illegible data carrier.
Since our program leaves neither additional nor preferences in the system, it
cannot cause any incompatibility with other hard- or software. The data car-
rier has been checked carefully with a special virus-scanner before being deli-
vered. Therefore, we are not liable for any damages in the computing machin-
ery. Is-dental cannot be held responsible for demands beyond operation-
range that are contained in the program or for failures in functioning due to
wrong use of the software.
It is the entire responsibility of the user to choose among the prosthetic solu-
tions suggested in the program, and to apple them correctly. Our liability is
limited to grant a maximum compensation for any defects up to the amount
paid for license charges.

Developed by Helmut Haumann
© by  is-dental, Germany 1996

Wilhelmstr. 8
48653 Coesfeld / Germany

Fon 0049 2541 6730
Fax 0049 2541 880582

E-Mail info@is-dental.com
All rights reserverd.

Unauthorized copying not allowed.

License
limitations

Legal liability
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